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Введение в САПР Altium Designer 
 

Altium Designer ‒ комплексная система автоматизированного 
проектирования (САПР) радиоэлектронных средств, разработанная 
австралийской компанией Altium. Ранее эта же фирма разрабатывала САПР P-
CAD, которая приобрела необычайную популярность среди разработчиков 
печатных плат. В 2008 г. фирма Altium заявила о прекращении поставки 
программных пакетов P-CAD и предложила разработчикам использовать 
программу Altium Designer, которая появилась в 2000 г. и изначально имела 
название Protel. В 2006 г.  был проведен ребрендинг программного продукта и 
он получил текущее название. Пособие будет базироваться на версии 2013 г. 
Altium Designer 14.1.5. 

САПР Altium Designer позволяет разработчику создавать проекты, начиная 
с принципиальной схемы, проводить моделирование полученных схем, 
подготовить файлы для производства, а концепция Live Design, так называемое 
живое проектирование, позволяет завершить проект его отладкой на плате 
NanoBoard. Контроль целостности проекта позволяет отслеживать изменения в 
частях проекта и синхронизировать их. Используя плату отладки NanoBoard, 
возможно отлаживать проекты на базе программируемых логических 
интегральных схем (ПЛИС) на этапе создания принципиальной схемы.  

Altium Designer объединяет аппаратное, программное и программируемое 
аппаратное обеспечение в пределах единой среды разработки, которая 
позволяет спроектировать и учесть все аспекты работы электронного 
устройства. Это комплексное решение позволяет Altium Designer превышать 
возможности традиционных средств разработки, открывая новые возможности 
проектирования, которые позволяют создавать интеллектуальные электронные 
приборы быстрее чем когда-либо.  

Рассмотрим основные возможности Altium Designer. 
1. Редактор схем. Максимально упрощенная реализация создания 

иерархических и многоканальных структур позволяет преобразовывать 
огромные и сложные схемы в набор простейших подсхем. Причем в структуре 
иерархии некоторые блоки могут быть реализованы в виде схем, а некоторые в 
виде VHDL-описания. Расширенный инструментарий редактора схем (рис. 1)  
позволяет создавать проекты любой сложности, а готовые блоки простейших 
логических элементов позволяют уйти от VHDL-описания к созданию 
структуры из готовых наработок. 

Все подсхемы иерархической структуры имеют принадлежность к 
определенной области на плате (Room), а все шины на схеме будут объединены 
в класс цепей, что значительно упрощает работу конструктора. 
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Рис. 1. Редактор схем 
 
Работа с большим набором документов проекта упрощается наличием 

миниатюрного окна просмотра, которое появляется при наведении указателя 
мыши на название документа в структуре проекта (рис. 2).  

 

 
 

Рис. 2.  Работа с редактором схем 
 

Аналогично при выборе порта на многолистовой схеме на экране 
появляются миниатюрные изображения листов, содержащих ответные части 
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выбранного порта. При разработке электрических принципиальных схем 
имеется возможность задавать конструктивные параметры будущей платы, 
например, формировать классы цепей и группы компонентов, а также 
описывать дифференциальные пары. На созданные классы цепей и 
дифференциальные пары можно сразу же установить ограничительные 
правила, такие как длину и толщину проводника, а также значение импеданса.  

2. Редактор библиотек.  Библиотеки программы содержат более 80 000 
компонентов и постоянно обновляются, причем имеется возможность импорта 
уже готовых библиотек из PCAD 2000‒2006. Кроме этого, имеется возможность 
создавать собственные библиотеки символов, посадочных мест, трехмерных 
моделей и текстовых SPICE-моделей для моделирования. Разработку 
библиотечных элементов можно проводить в режиме мастера, который 
позволяет путем последовательного ввода информации о компоненте получить 
готовую модель с минимальными затратами времени. 

3. Моделирование. Altium Designer позволяет выполнять стандартный 
набор процедур смешанного цифроаналогового моделирования. Запуск 
цифроаналогового моделирования на базе SPICE 3f5/XSpice происходит 
непосредственно с введенной принципиальной схемы и предоставляет в 
распоряжение разработчика мощные средства анализа (рис. 3), включая такие, 
как вариация параметров и статистический анализ методом Монте-Карло. В 
комплект поставки включено более 20 000 математических моделей.  

 

 
 

Рис. 3. Моделирование в Altium Designer  
 

Би
бл
ио
те
ка

 БГ
УИ
Р



7 
 

4. Анализ целостности сигналов (Signal Integrity). Предварительный 
расчет импеданса и возможных отражений может быть выполнен на 
схемотехническом уровне еще до этапа компоновки и трассировки печатной 
платы, позволяя предотвратить возможные проблемы на ранних стадиях 
проектирования и правильно подобрать элементную базу. Импедансы, 
отражения и возможные перекрестные отражения могут быть уточнены 
(перерасчитаны) на заключительных этапах разработки и контроля топологии.  
Целостность сигналов может быть проанализирована при верификации 
(функция DRC) топологии. В этом случае ограничения на возможные 
искажения задаются, как и прочие правила проектирования (о нарушении 
которых выдаются соответствующие сообщения). В случае обнаружения 
проблем, связанных с целостностью сигналов, функция Termination Advisor 
поможет разработчику подобрать необходимую схему согласования для 
устранения выявленных недостатков. 

5. Редактор печатных плат. С помощью мощной, полностью 
визуализированной системы задания и проверки правил проектирования 
пользователь получает полный контроль над процессом разработки топологии. 
Система задания правил проектирования (рис. 4) состоит из 51 позиции, 
которые разбиты на 10 категорий, включая такие, как правила трассировки, 
производства, правила проектирования высокочастотных блоков, правила 
разводки дифференциальных пар и т. д.  

 

 
 

Рис. 4. Редактор печатных плат 
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Используя технологию запросов, пользователь может точно описать 
область действия того или иного правила, а с помощью установки приоритета 
действия можно использовать одно и то же правило на разных уровнях проекта 
(например, весь проект, или класс цепей, или класс компонентов, или цепь, 
проходящая по внутреннему слою, и т. д.) Например, пользователь может 
описать требуемые толщины проводников и зазоры между ними, которые будут 
жестко соблюдаться во время интерактивной и автоматической трассировки. 

Мощные возможности интерактивной трассировки, такие как трассировка 
нескольких параллельно идущих проводников (Multiple Traces) и разводка 
дифференциальных пар, вместе с рациональным набором правил 
проектирования значительно ускоряют работу конструктора. В режиме 
интерактивной трассировки используются следующие технологии: Push and 
Shove, позволяющая расталкивать уже существующие трассы и переходные 
отверстия, Walkaround ‒ располагает трассы максимально близко к 
существующим, Hugging ‒ уплотняет существующую топологию вновь 
прокладываемой дорожкой. Все режимы интерактивной трассировки 
распространяются и на трассировку дифференциальной пары, и на трассировку 
шин. В режиме трассировки дифференциальных пар имеется возможность 
установки переходных отверстий.  

Встроенный топологический трассировщик Situs имеет обширный 
инструментарий для решения задач трассировки печатных плат с высокой 
плотностью компоновки элементов. В отличие от традиционных 
трассировщиков, Situs «умеет» прокладывать печатные проводники по 
неортогональным направлениям с интеллектуальным выбором слоев. 
Неоспоримым плюсом данного трассировщика является полностью 
управляемый и настраиваемый вручную алгоритм. Топологические алгоритмы 
трассировки позволяют выполнять трассировку очень эффективно даже при 
использовании компонентов сложной формы, при этом удается избегать 
лишних этапов «зачистки» топологии. Новая версия этого трассировщика 
значительно повышает процент завершенности трассировки и улучшает работу 
с экранными и «расщепленными» экранными слоями, а также повышает 
эффективность применения перешейков проводников у планарных контактных 
площадок. 

6. Возможности импорта. Встроенный помощник импорта проектов (рис. 5) 
позволяет импортировать схемы, платы, библиотеки из систем PCAD, OrCAD, 
PADs, DxDesigner, Allegro PCB, преобразовывая их в проекты Altium Designer. 
Трансляции подлежат проекты, сохраненные как в бинарной (Binary), так и в 
ASCII кодировке, что позволяет без проблем работать в данной системе с 
проектами, ранее созданными в других САПР. При трансляции библиотек 
сторонних программ имеется возможность сохранять их в виде баз данных, что 
упрощает управление библиотеками и делает более доступным электронный 
документооборот.  
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Рис. 5. Импортирование проектов в Altium Designer 
 

7. Работа с трехмерными моделями. Ориентация последних релизов 
Altium Designer на MCAD и формат STEP выразилась в возможности 
параллельной работы в ECAD ‒ MCAD. Данная возможность является 
принципиально новой для программ такого класса и назначения. В Altium 
Designer возможно открыть готовый узел РЭУ с установленными в нем одной 
или несколькими платами и разрабатывать далее плату с учетом ее сопряжения 
с механическими деталями и другими платами (рис. 6).  

 

 
 

Рис. 6. Работа с 3D-моделями в Altium Designer 
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Изменения, внесенные в одну из ячеек плат или механических деталей, 
можно мгновенно перенести обратно в MCAD. Аналогично, исправив деталь 
корпуса или плату в MCAD путем обновления моделей в Altium Designer, 
вносятся все изменения в редактор плат. В редакторе плат можно постоянно 
переключаться между двухмерным и трехмерным режимом, учитывая 
сопряженность деталей в сборке и внося изменения на плоскости платы. 

8. Проектирование ПЛИС. Altium Designer ‒ первая система 
проектирования устройств, реализуемых в виде печатной платы, признающая 
важность и актуальность программируемой логики в современных электронных 
устройствах.  

Подобное понимание реализуется в виде обширного инструментария для 
проектирования устройств на базе ПЛИС, при этом от разработчика не 
требуется знания языка VHDL ‒ проект может быть введен в виде 
принципиальной схемы с использованием поставляемых библиотек готовых 
логических устройств (подобные библиотеки полностью синтезированы и 
протестированы). Облегчает выполнение подобных задач уникальная 
технология компании Altium ‒ LiveDesign, позволяющая в интерактивном 
режиме разрабатывать и отлаживать проектируемое устройство 
непосредственно в кристалле.  

Комбинация виртуального инструментария и технология периферийного 
сканирования позволяют разработчику постоянно «взаимодействовать» с 
выполняющимся проектом в плате отладки NanoBoard и «видеть» реальные 
сигналы в ПЛИС. Измененный проект может быть перезагружен в NanoBoard в 
любой момент. Этот процесс взаимодействия в реальном времени с «живым» 
проектом компания Altium и называет LiveDesign. Эта технология позволяет 
быстро разработать устройство на базе ПЛИС и не только отказаться от 
использования описания на языке VHDL, но и от VHDL-моделирования. 
Утомительная и кропотливая работа по синхронизации распиновки ПЛИС и 
топологии теперь может выполняться автоматически. Инструментарий 
автоматического (или ручного) сваппирования выводов автоматически 
оптимизирует распиновку ПЛИС для более качественной трассировки 
топологии. 

9. Выходная документация. Altium Designer поддерживает широкий 
перечень выходных форматов, таких как ODB++, Gerber, NC Drill, IPC-D-356, 
VHDL, может генерировать списки соединений в форматах большинства 
сторонних систем проектирования, а также генерировать разнообразные отчеты 
(например, Bill of Materials, на основе которого довольно просто оформить 
перечни элементов и спецификации по ЕСКД с помощью утилиты 
«Документатор отечественной разработки»). Встроенная и полностью 
интегрированная с системой проектирования топологии система 
технологического анализа и предпроизводственной доработки топологий 
CAMtastic позволяет выполнять 18 разнообразных проверок на 
технологичность проекта с возможностью автоматического устранения 
большинства ошибок, мощные средства редактирования фотошаблонов, файлов 
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сверловки и фрезеровки позволяют внести необходимые коррективы. Среди 
представленного инструментария присутствует обширный набор функций 
графического редактирования, создания  многоместных шаблонов (в том числе 
и на основе разных топологий) и т. д.  

10. Русифицированный интерфейс. Отличительной особенностью Altium 
Designer  является наличие возможности работы с русифицированным 
интерфейсом. Имеется возможность использовать полностью 
русифицированную программу или включить только всплывающие подсказки 
на русском языке, в то время как весь интерфейс будет представлен в 
стандартном англоязычном виде.  

Базовой концепцией формирования данных, вырабатываемых в Altium 
Designer и относящихся к одному объекту того или иного вида, является 
проект. Проект представляет собой текстовый файл-оболочку, объединяющий 
иерархически организованный набор документов, предполагающих 
воплощение их в единственном объекте. 

В Altium Designer поддерживается несколько видов проекта: 
1. Проект печатной платы (PCB Project). Формируется на базе электронной 

схемы, предварительно созданной в редакторе схем из библиотечных символов. 
В проекте печатной платы каждый компонент представлен как посадочное 
место (корпус), а проводники преобразованы в соединительные линии от 
вывода к выводу. На данном этапе определяется окончательный вид платы, 
совместно с физическими слоями платы, описываются правила проектирования 
для изготовления фотошаблона, такие как ширины проводников и зазоры. 
Компоненты размещаются в пределах контура платы и соединяются линиями 
связей, которые затем заменяются трассами, вручную или автоматически. 
Когда проект закончен, генерируются выходные файлы в стандартных 
форматах, которые можно использовать для изготовления платы, установки 
компонентов на сборочной машине и т. д. 

2. Проект ПЛИС (FPGA Project). Имя файла оболочки проекта *.PrjFpg. 
Представляет собой набор документов, которые могут быть обработаны для 
программирования ПЛИС. Проект создается с помощью редактора схем и (или) 
программированием на языке HDL (VHDL или Verilog). Добавляются файлы 
ограничений в проект для описания требований проекта, таких как 
программируемое устройство, внутреннее распределение выводов для цепей и 
устройств, требований к быстродействию цепи, определения частот на выводах 
и т. п. Синтез проекта транслирует исходные данные в набор вентилей низкого 
уровня, в стандартный формат файла, известный как EDIF. Инструментарий 
производителя устройства затем обрабатывает данные EDIF и пытается 
разместить и трассировать проект таким образом, чтобы встроить данные в 
указанное предназначенное устройство, производя программный файл 
устройства. Проект затем может быть применен в предназначенном устройстве, 
установленном в подходящей разработанной плате и проект можно 
тестировать. 
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Разработка данного проекта начинается с формирования схемного или 
HDL-описания логики проектируемого устройства. Добавляются файлы 
ограничений в проект для описания требований проекта, таких как 
программируемое устройство, внутреннее распределение выводов для цепей и 
устройств, а также требований к быстродействию цепи, определения частот на 
выводах и т. п. Заданная логика компилируется в комбинации логических ячеек 
нижнего уровня внутренней структуры ПЛИС. Результаты логического синтеза 
выдаются в виде описания в конструкциях языка обменного формата EDIF. 
Инструментарий производителя устройства затем обрабатывает данные EDIF и 
пытается разместить и трассировать проект таким образом, чтобы встроить 
данные в указанное предназначенное устройство, производя программный файл 
устройства. Проект затем может быть применен в предназначенном устройстве, 
установленном в подходящей разработанной плате и проект можно 
тестировать. 

Завершающей стадией реализации такого проекта является исполнение 
всего устройства (с резисторами, конденсаторами, микросхемами более низкой 
степени интеграции) в виде ячейки (модуля) на печатной плате, т. е. 
выполнение проекта печатной платы, на которой ПЛИС выступает как 
обычный компонент, наравне с остальными. 

3. Интегрированная библиотека. Имя файла-оболочки *.LibPkg; имя файла- 
библиотеки *.IntLib. В редакторе библиотек формируются наборы условных 
графических обозначений (УГО) электрорадиокомпонентов и к ним 
добавляются четыре типа моделей: описание посадочного места компонента на 
плате, данные для схемного моделирования, моделирования целостности 
сигналов и трехмерные модели. Файлы описаний моделей либо ссылки с 
указанием пути к ним включаются в структуру библиотечного пакета *.LibPkg. 
Исходные схемные библиотечные символы и требуемые модели затем 
компилируются в единый файл, называемый интегрированной библиотекой. 

4. Встроенный проект (Embeded Project). Имя файла-оболочки *.PrgEmb. 
Представляет собой набор проектных документов, образующих программное 
приложение. Исходный текст программы и/или подпрограмм формируется в 
конструкциях языка С или Ассемблера, компилируется в объектные модули; 
подпрограммы связываются в исполняемый модуль в машинном коде, готовый 
для загрузки в выбранный процессор или микроконтроллер. 

5. Проект ядра (Core Project). Имя файла-оболочки *.PrjCor. По существу, 
это первая половина ПЛИС-проекта, заканчивающаяся формированием 
графического схемного символа и описания логики в формате EDIF. 

6. Скрипт-проект (*.PrjScr). Используется для программирования в среде 
Altium Designer, имеет целью модификацию объектов в других открытых 
проектах. Для управления используется интерфейс программирования 
приложений API (DXP Application Programming Interface). 

Наиболее часто используемые термины в среде Altium Designer (AD): 
‒ компонент (Component): общее наименование объекта, который может 

быть применен в проекте (включает все типы моделей); 
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‒ символ (Symbol): общее наименование условного графического 
обозначения (УГО) компонента, подготовленного для размещения на схеме. 
Символ может содержать графические объекты, которые определяют внешний 
вид и выводы, которые определяют электрические точки подключения. В AD 
символ является полностью завершенным объектом, т. к. к нему подключаются 
все модели; 

‒ часть (секция) (Part): некоторые компоненты, такие как резисторные 
цепочки или реле, могут быть построены как серия отдельных секций (частей), 
которые, в свою очередь, могут быть размещены на схеме независимо 
(рассматриваются как многосекционный компонент), но имеют один корпус; 

‒ модель (Model): представление компонента, который используется в 
некоторой практической сфере деятельности. При создании печатной платы 
(ПП) – это модель посадочного места, при моделировании – модели Spice,     
IBIS и т. д.; 

‒ посадочное место (Footprint): это наименование используется для 
модели, которая представляет компонент на заготовке печатной платы. 
Посадочное место группирует набор контактных площадок (КП) на плате и 
форму компонента (очертание корпуса), которое определяет часть платы, 
требуемую для монтажа и соединения физического компонента на плате.  

В среде AD имеется четыре типа библиотек, рассмотрим назначение 
каждой из них. 

1. Библиотеки моделей. Модели для каждой области сохраняются в 
«хранилищах», обычно называемых библиотеками моделей. В некоторых 
областях, таких как SPICE, где обычно одна модель хранится в одном файле, 
они также рассматриваются как отдельные файлы (*.MDL, *.CKT). В других 
областях модели обычно группируются в библиотечные файлы, 
соответствующие заданной организации пользователя, такие как посадочные 
места, сгруппированные в библиотеки пакетного типа (*.PcbLib).  

2. Библиотеки символов содержат схемные компоненты и интерфейс 
определения их моделей (*.SchLib). Каждый интерфейс определения модели 
привязан к своей соответствующей библиотеке моделей.  

3. Интегрированные библиотеки ‒ это набор библиотек символов, которые 
вместе с их привязанными библиотеками моделей  «компилированы» в 
интегрированную библиотеку (*.IntLib). Преимущество компиляции в 
интегрированную библиотеку состоит в том, что вся компонентная информация 
доступна в едином портативном файле. Интегрированные библиотеки не могут 
быть отредактированы без распаковки источников и перекомпиляции.  

4. Библиотеки базы данных ‒ библиотека, где все символьные ссылки, 
привязанные модели и параметрическая информация хранится в базе данных на 
основе ODBC, ADO или в формате таблиц Excel. Каждая запись в базе данных 
представляет компонент, все сохраненные параметры вместе со ссылками на 
модели. Запись может содержать ссылки на инвентарную ведомость или на 
другие корпоративные данные компонентов.  
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На схемной стадии проект является набором компонентов (рис. 7), которые 
имеют логическую связность.  

 

 
 

Рис. 7. Информация о разных вариантах представления компонента в файлах 
моделей 

 
Для тестирования или проведения проекта в жизнь он нуждается в 

передаче в другую область проверки функционирования, такую как 
моделирование, формирование платы, анализ целостности сигналов и т. д. 

Каждый домен (область практической реализации компонента) требует 
некоторую информацию о компонентах (рис. 8), а также некоторые пути 
перераспределения этой информации касательно выводов символа. Некоторая 
часть из этой информации для домена размещается в файлах моделей, формат 
которых является обычно предопределенным. Например, модели IBIS, MDL 
(принцип минимальной длины описания) и CKT. Некоторая информация не 
содержится в файлах моделей, например, распределение выводов SPICE и 
данные списков цепей должны быть определены средствами системы.  

Би
бл
ио
те
ка

 БГ
УИ
Р



15 
 

 
 

Рис. 8. Связи в модели  
 
Вся необходимая информация домена содержится внутри схемного 

компонента, который сохраняется с помощью отдельного интерфейса для 
каждой добавляемой модели. В сущности, комплектная модель является 
комбинацией распределенной информации моделей, сохраняемой в 
компоненте, а информация о модели домена сохраняется в библиотеке моделей. 
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Лабораторная работа №1 
 

Создание компонентов в среде Altium Designer 
 

Цель работы: изучить основные принципы организации библиотек и 
создания компонентов в среде Altium Designer, создать пользовательскую 
интегрированную библиотеку на базе библиотек символов и посадочных мест. 

 
1.1. Создание библиотеки символов 

 
Для создания новой библиотеки необходимо выполнить 

File>New>Library>Schematic Library. Сохранить библиотеку командой 
File>Save as в нужную папку. Внизу панели Projects отображаются активные 
панели. По умолчанию там уже установлена вкладка SCH Library. Для начала 
создания УГО необходимо сделать ее активной. После чего интерфейс AD 
примет вид, как показано на рис. 9. 

 

 
 

Рис. 9. Интерфейс редактора компонентов 
 

Для настройки рабочей области редактора компонентов необходимо 
активизировать команду главного меню Tools>Document Options и настроить в 
диалоговом окне Library Editor Workspace (рис. 10) основные элементы 
рабочего пространства редактора библиотек:  

• Units – система единиц измерения – установить метрическую систему 
единиц;  

• Grids>Snap – сетка захвата при построении графики; 
• Grids>Visible – сетка, видимая на экране. 
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Рис. 10. Настройка рабочей области редактора символов 
 
Кроме этого, можно задать менее необходимые на этом этапе параметры: 
• Style – стиль размеров, по умолчанию заданные стили не соответствуют 

ГОСТ; 
• Size – формат листа; 
• Border – цвет границы листа; 
• Custom size – пользовательский размер листа; 
• Show Border – показать границы листа; 
• Show Hidden Pins – показать скрытые выводы; 
• Always Show Comment/Designator – всегда показывать атрибуты. 
В открытой панели редактирования SCH Library с пустым шаблоном 

Component_1 (можно просто переименовать этот, уже существующий, или 
создать новый) начать процедуру формирования логического символа схемной 
библиотеки (например, NPN-транзистора): 

1. Для переименования: указать курсором имя Component_1 и 
активизировать команду главного меню Tools>Rename Component. Внести имя 
NPN в поле имени окна Rename Component и завершить переименование 
нажатием кнопки OK. Для создания нового компонента следует нажать кнопку 
Add под списком компонентов данной библиотеки в панели SCH Library и в 
появившемся окне написать название нового компонента. 

2. Установить точку привязки графики условного графического 
обозначения (УГО) в центр окна редактирования командой главного меню 
Edit>Jump>Origin (горячие клавиши J, O). На графическом экране окна 
редактирования эта точка помечается перекрестием. Вокруг этой точки обычно 
строится вся графика УГО. В дальнейшем при вызове логических символов из 
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библиотеки и размещении их на поле электрической схемы программа ведет 
символ за электрическую «горячую точку» (hot end или hot point) – окончание 
линии электрического контакта, ближайшего к точке привязки графики. 

3. Целесообразно установить шаг сетки захвата 0,5 мм, а шаг видимой 
сетки 5 мм. 

4. Вычертить в окне графического редактирования УГО NPN-транзистора 
(рис. 11, а). 

 

 
 

Рис. 11. Пример УГО биполярного транзистора 
 

При создании УГО дискретных аналоговых компонентов по ЕСКД 
необходимо сформировать графику УГО и разместить электрические контакты 
схемного элемента (символа) в узлах сетки, единой для всех, как аналоговых, 
так и цифровых компонентов. В качестве такой оптимальной сетки при 
проектировании электрических схем по ЕСКД целесообразно использовать 
сетку с шагом 5 мм. Именно в таком модульном шаге формируются в 
соответствии с ГОСТ 2.743‒91 и ГОСТ 2.759‒82 УГО аналоговых и цифровых 
интегральных микросхем. 

Рассмотрим особенности формирования схемного символа на примере 
биполярного транзистора. В соответствии с ГОСТ 2.730‒73 УГО биполярного 
транзистора формируется геометрическим построением. В круге диаметром 12 
или 14 мм под углом 60° друг к другу и симметрично относительно диаметра 
строятся два луча. Размер А между исходной точкой лучей и точкой их 
пересечения с окружностью составляет 9 или 11 мм и определяет все остальные 
размеры УГО. Линия базы транзистора строится на расстоянии 0,5 А от 
исходной точки лучей и имеет длину, также равную А (см. рис. 11, а). 

При таком построении УГО координаты точек сопряжения элементов 
графики выражаются иррациональными числами. Программа, конечно, 
округляет эти координаты до значения младшего разряда машинного слова, но 
все равно точки присоединения проводников схемы не попадают в узлы 
приемлемой сетки проектирования. 

Представляется рациональным решение, изображенное на рис. 11, б. 
Линии УГО проводятся через узлы 5-миллиметровой сетки, штрихи 
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электрических контактов также имеют длину 5 или 10 мм, а окружность, 
изображающая корпус транзистора (ее изображение, по ГОСТ 2.730‒73, с 
изменением ИУС №6 от 1989 г., не обязательно), смещена вправо так, что ее 
контур проходит через точки окончания линий эмиттера и коллектора. Угол 
раствора коллектора и эмиттера составляет при этом 53°. На глаз различия 
изображений рис. 11, а и б совершенно незаметны. 

Рисование графики символа: 
1. Активизировать команду главного меню Place>Line. Курсор меняет вид 

на перекрестие. Графический примитив Line представляет собой полилинию – 
все отрезки ломаной линии образуют единый объект. 

2. Клавишей Tab активизировать функцию настройки ширины линии. 
Открывается диалоговое окно настройки PolyLine (рис. 12).  

 

 
 

Рис. 12. Свойства линии 
 
В окно вынесены следующие настройки линии: 
• Line Width – ширина линии: курсором указывается один из вариантов 

ширины: 
– Smallest – тонкая, шириной около 0,1 мм; 
− Small – тонкая,  шириной 0,254 мм; 
− Medium – средняя,  шириной около 0,5 мм; 
− Large – большая,  шириной около 1 мм; 
• Line Style – стиль – сплошная (Solid), точечная (Dotted) или пунктирная 

(Dashed); 
• Color – цвет – выбирается из цветовой палитры, открывающейся по 

щелчку левой кнопки мыши на цветном прямоугольнике; 
• фигуры, которыми начинается и заканчивается линия – Start Line Shape и 

End Line Shape – стрелки, точки, квадраты и т. п., или отсутствие фигур (None), 
а также размер этих фигур-наконечников (Line Shape Size). Щелчком по кнопке 
ОК завершить настройку. Черчение очередного отрезка завершается щелчком 
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правой кнопки мыши или клавишей Esc. Перед вычерчиванием линии эмиттера 
клавишей Tab снова активизировать настройку параметров и указать стрелку на 
конце отрезка. 

3. Активизировать команду черчения дуги Place>Arc. Клавишей Tab 
активизировать диалоговое окно настройки параметров дуги (рис. 13). 

 

 
 

Рис. 13. Диалоговое окно настройки параметров дуги 
 

В диалоговом окне указываются следующие параметры: 
• Line Width – ширина линии; 
• Color – цвет; 
• Radius – радиус дуги; 
• Start Angle – начальный угол, в абсолютных координатах; 
• End Angle – конечный угол, также в абсолютных координатах. 
4. Указать радиус 6 мм, начальный угол 0 (нуль) и конечный угол 360°. По 

щелчку ОК вычерчивается окружность диаметром 12 мм. 
5. Переместить и зафиксировать окружность в таком положении, чтобы 

концы линии эмиттера и коллектора лежали на окружности. 
Присоединение электрических выводов: 
1. Активизировать команду главного меню Place>Pin (горячие клавиши P, P). 

На графическом экране появляется изображение электрического контакта, 
перемещающееся за курсором по экрану. Точка присоединения электрической 
связи к контакту помечена косым перекрестием. В лексике Altium Designer эта 
точка называется «горячим концом» (hot end). При совмещении вывода с УГО 
линия вывода должна примыкать к УГО противоположным концом. 

2. Перед размещением вывода активизировать клавишей Tab диалог 
редактирования его свойств. Открывается диалоговое окно настройки свойств 
вывода Pin Properties (рис. 14). 
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Рис. 14. Диалоговое окно настройки свойств 
 

Установить следующие свойства вывода: 
• Display Name – логическое имя или функциональное назначение 

контакта. В соответствии с требованиями SPICE-технологии 
схемотехнического моделирования последовательность ввода и обозначений 
выводов транзистора должна быть следующей: коллектор ‒ база ‒ эмиттер. По 
умолчанию первому вводимому контакту дается обозначение 0 (нуль). 
Изменим это обозначение на 1. Обозначения следующих выводов 
автоматически инкрементируются; 

• Designator – имя или цоколевочное обозначение вывода, используемое 
при автотрассировке. По умолчанию это обозначение совпадает с обозначением 
Display Name и также инкрементируется. Присвоим ему также обозначение 1. 
Целесообразно также отключить видимость обозначений выводов, т. к. их 
функциональное назначение в случае транзистора ясно из графики УГО 
(видимые обозначения будут у выводов микросхем); 
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• Electrical Type – электрический тип вывода. Для выводов транзистора 
установить тип Passive; 

• Description – текстовое описание функции вывода компонента; 
• в поле Graphical установить: 
 ‒ Length – длину линии вывода, равную 5 мм; 
 ‒ Orientation – ориентацию линии: установить угол разворота линии 

вывода (против часовой стрелки, относительно положительного направления 
оси X). Ориентация может также меняться при установке вывода на 
графическом экране последовательными нажатиями клавиши ПРОБЕЛ 
(SPACE); 

• в поле Symbols оставить без изменения признак No Symbol – отсутствие 
указателей полярности, направления передачи сигнала и т. п. 

3. Щелчком кнопки ОК завершить редактирование свойств вывода и 
установить его на УГО в окне графического редактирования компонента. 

4. Повторить действия пп. 2, 3 для следующих выводов компонента. 
Последовательность ввода оставшихся выводов – база, эмиттер. 

5. Командой главного меню File>Save cохранить построенный компонент в 
библиотеке.  

К многосекционным компонентам относятся резисторные, 
конденсаторные, диодные и транзисторные сборки и матрицы, электрические 
соединители, некоторые логические интегральные микросхемы. Схемный 
символ многосекционного компонента может быть построен целиком, со всеми 
секциями в едином УГО. В этом случае создание такого символа ничем не 
отличается от рассмотренного выше. Однако, для формирования 
принципиальной электрической схемы, которая бы легко читалась и наглядно 
демонстрировала принцип действия функционального узла, такое изображение 
не всегда удобно. При создании многосекционных компонентов нужно учесть 
следующее: 

1) не все секции до одной всегда используются в схеме, а видимость 
неиспользуемых невозможно отключить. В результате схема загромождается 
лишними УГО; 

2) из соображений удобочитаемости схемы и понимания ее 
функционирования часто бывает удобно изображать схему разнесенным 
способом. При едином УГО на весь компонент это невозможно и приходится 
тянуть к нему линии электрической связи издалека, что затрудняет чтение 
схемы. 

Поэтому целесообразно рассмотреть особенности формирования схемного 
символа многосекционного компонента разнесенным способом – на примере 
логической интегральной микросхемы К511ПУ2, содержащей два 
двухвходовых вентиля 2И-НЕ и два вентиля И-НЕ в одном корпусе: 

1. Переименовать пустой компонент Component_1 в плавающей панели 
SCH Library, присвоив ему имя К511ПУ2 и установить точку привязки графики 
в центре главного окна графического редактора.  
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2. Активизировать команду главного меню Place>Line и вычертить квадрат 
УГО со стороной 15 мм. 

3. Активизировать команду главного меню Place>Pin и вызвать клавишей 
Tab диалог настройки свойств электрического вывода. 

Назначить первому выводу: 
• Designator – 1, в соответствии с цоколевкой микросхемы;  
• Display Name ‒ Е; 
• электрический тип ‒ Passive, чтобы избежать размещения меток, 

противоречащих требованиям ЕСКД. 
Закрыть диалог настройки и зафиксировать первый вывод в главном окне 

графического редактора. 
4. Продолжить установку следующих выводов. Для ввода значка инверсии 

(вывод Out) используется знак «\», который может использоваться для этого в 
двух режимах: либо один «\» в начале имени (создает черту над всем 
названием), либо знак «\» после каждого символа имени (в этом случае часть 
имени будет со знаком инверсии, другая – без).  

5. Создав первую ячейку микросхемы, необходимо повторить первые два 
шага и создать остальные три ячейки, при этом на символе позиционные 
обозначения выводов должны совпадать с реальными номерами ножек 
микросхемы. Для создания новой ячейки внутри компонента выполняется 
команда Tools>New Part. 

Скрытые выводы питания и земли – это чаще всего выводы цифровых 
интегральных схем, подключаемые к цепям питания и Общего (Земли). При 
традиционном ручном способе черчения электрических схем эти выводы на 
схеме не показывались, а необходимость их присоединения к цепям питания и 
Общего указывалась в текстовых технических требованиях на поле чертежа. 

В P-CAD, Altium Designer и других САПР могут использоваться два 
подхода к формированию и использованию этих выводов при выполнении 
электрической схемы. 

При первом подходе в компонент вводится специальная секция с 
выводами питания и Общего. В терминологии P-CAD такие компоненты 
называются гетерогенными. Цепи питания и Общего подводятся к выводам 
этих секций так же, как и сигнальные цепи к выводам логических секций. 

При втором подходе выводы питания и Общего делаются скрытыми. Они 
объединяются программой в цепь с назначенным именем (в P-CAD эти цепи 
имеют статус «глобальных»), и разработчику остается только обеспечить вывод 
этой цепи на контакт соединителя или лепесток для подачи питания на плату. 

Рассмотрим процедуру формирования скрытых выводов питания и Общего 
в Altium Designer  на примере интегральной микросхемы КР1564ЛА3. 

1. Активизировать команду главного меню View>Show Hidden Pins. По 
этой команде делаются видимыми все скрытые выводы компонента, а также 
скрытые имена и другие обозначения у видимых выводов. 

2. Указать курсором в плавающей панели SCH Library на значок 
компонента KR1564LA3 (всего компонента, а не отдельной секции!). В главном 

Би
бл
ио
те
ка

 БГ
УИ
Р



24 
 

графическом окне редактора библиотек (рис. 15) отображается УГО первой 
секции компонента. 

 

 
 

Рис. 15. Пример изображения выводов питания и земли 
 

3. Активизировать команду главного меню Place>Pin и вызвать клавишей 
Tab диалог предварительного редактирования свойств вывода. 

4. В диалоговом окне Pin Properties: 
• обозначениям Display и Name Designator присвоить цоколевочный номер 

вывода 7; 
• признаку Electrical Type установить значение Power; 
• составить описание (Description): Ground_pin; 
• указать номер секции (Part Number) 0 (нуль), при таком обозначении 

выводы питания и Земли присоединятся к каждой секции компонента; 
• активизировать признак Hide – скрыть вывод на УГО; 
• в поле Connect to указать имя цепи GND – Земля. 
Щелчком кнопки ОК завершить редактирование и зафиксировать вывод в 

ближайшем к контуру УГО узле сетки проектирования. 
5. Повторить те же действия, установив при этом описание Supply_pin, 

цоколевочный номер вывода 14 и имя цепи питания VCC.  
6. Селектируя по очереди секции компонента в плавающей панели SCH 

Library, убедиться, что у каждой секции появились выводы 7 и 14. Если это так, 
снять активность команды главного меню View>Show Hidden Pins. 

7. Командой главного меню File>Save сохранить компонент с 
подключенными скрытыми выводами. 
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В Altium Designer любой вывод может быть скрытым. Кроме того, должно 
быть явно обозначено имя цепи, к которой подключаются скрытые выводы. 

Для редактирования свойств компонента необходимо вызвать окно свойств 
компонента (рис. 16).  

 

 
 

Рис. 16. Окно свойств компонента 
 

В поле Default Designator внести буквенный префикс позиционного 
обозначения. Добавить в строку с префиксом вопросительный знак. При 
составлении электрической схемы на его место в позиционное обозначение 
вносится порядковый номер компонента (в пределах группы функционально 
однородных). В поле Comment вписать строку комментария. В поле Description 
вписать описание компонента, по которому он будет отыскиваться при 
активизации поисковой системы. В нашем случае для настройки информации о 
транзисторе описание может быть, например, Transistor NPN Generic. 
Остальные поля в правой половине окна остаются пока свободными. Они будут 
заполняться при присоединении к компоненту моделей. 

Установка эквивалентности выводов и ячеек происходит следующим 
образом. Находясь в редакторе схем, выполним команду Tools>Configure Pin 
Swapping, в результате которой на экран выводится окно, в котором показаны 
все компоненты данной библиотеки с информацией об эквивалентности            
(в правых столбцах). В списке нужно выбрать необходимый компонент, 
например ранее созданный К511ПУ2, и нажать кнопку Configure component 
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(или двойное нажатие на названии компонента в списке). После этого на экране 
появится окно, показанное на рис. 17. 

 

 
 

Рис. 17. Установка эквивалентности для выводов микросхемы К511ПУ2 
 
Обозначение полей в окне настройки: 
‒ Pin Swapping – эквивалентность выводов; 
‒ Differential Pair Swapping – эквивалентность дифференциальных пар; 
‒ Part Swapping – эквивалентность ячеек компонентов. 
Для определения группы выводов как логически эквивалентных, нужно 

для всей группы выводов установить одинаковое значение в столбце Pin Group. 
Для запуска проверки, находясь в редакторе библиотеки символов, 

выполнить команду Reports>Component Rule Check. В результате на экране 
появляется окно (рис. 18), в котором расположены две группы проверки.  
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Рис. 18.  Проверка библиотеки компонентов 
 

В группе Duplicate проверяется наличие одноименных компонентов и 
одинаковых номеров выводов. В группе Missing проверяется наличие описания 
(Description), посадочного места (Footprint), позиционного обозначения (Default 
Designator), имени вывода (Pin Name), номера вывода (Pin Number) и 
нарушение сквозной нумерации выводов (Missing Pins in Sequence). После 
запуска проверки программа формирует и открывает  новый файл с 
расширением ERR и названием, соответствующим названию библиотеки. Если 
библиотека не содержит ошибок, то этот файл будет содержать только 
заголовок, в противном случае будет выдан только отчет об ошибках. Перечень 
ошибок здесь представлен в виде обычного текстового файла и нет 
возможности навигации по ошибкам, как это сделано, например, в редакторах 
схем и плат. Ошибки в библиотеке придется обнаруживать и исправлять 
вручную. В конечном результате после проверки окно файла *.ERR не должно 
содержать списка ошибок. 

 
1.2. Создание библиотеки посадочных мест 

 
Создание посадочного места начинается с создания новой библиотеки, для 

чего выполняется команда File>New>Library>PCB Library. В результате на 
экране после выбора закладки PCB Library появляется окно, представленное на 
рис. 19. 
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Рис. 19. Интерфейс редактора посадочных мест 
 

Для установки настроек выполнить команду Tools>Library Options. На 
экране появляется окно, показанное на рис. 20. 

 

 
 
Рис. 20. Окно настройки рабочей области редактора посадочных мест 
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В появившемся окне в поле Unit выбрать систему единиц измерения           
(в нашем случае  метрическую), шаг сетки (Snap Grid), шаг сетки для установки 
компонентов (Component Grid, для библиотек эта сетка не используется) и две 
видимые сетки (Grid 1 и Grid 2). 

Видимые сетки задаются относительно сетки Snap Grid, первая должна 
быть равна шагу сетки, вторую удобно поставить в 10 раз больше. Наиболее 
важной здесь является сетка Electrical Grid, или сетка привязки, она определяет 
прямоугольную область внутри контактной площадки, при захвате на которую 
курсор «залипает» на центре отверстия. Snap On All Layer обеспечивает 
привязку на все слои, Snap To Board Outline – привязку к углам платы              
(не используется в редакторе посадочных мест).  

Алгоритм создания посадочного места: 
1. В свободном поле главного окна щелкнуть левой кнопкой мыши, после 

чего нажать несколько раз клавишу Page Up, в результате на экране станет 
видна сетка. В результате выполнения этих шагов рабочее пространство 
оказывается подготовленным для формирования посадочных мест 
компонентов. По умолчанию графический редактор имеет структуру слоев, 
обеспечивающую проектирование двухсторонней печатной платы: 

• Top Layer – верхний слой печатных проводников; 
• Bottom Layer – нижний слой печатных проводников; 
• Mechanical 1 – первый «механический» слой (для изображения 

радиаторов и других элементов сборки); 
• Top Overlay – слой шелкографии; 
• Keep-Out Layer – слой барьеров трассировки; 
• Multi-Layer – «мультислой» – слой контактных площадок. 
Формирование посадочного места компонента заключается в определении 

его конструкции и размещении в рабочем пространстве редактора PCB 
Component Editor контактных площадок для электрического подсоединения, а 
также черчении линий контура компонента. Линии контура располагаются 
обычно в слое шелкографии Top Overlay. Контактные площадки для монтажа 
компонентов со штыревыми выводами формируются в слое Multi-Layer. 
Контактные площадки для поверхностно-монтируемых компонентов 
формируются в верхнем сигнальном слое Top Layer. 

2. Переименовать открытое в панели PCB Library пустое посадочное место 
PCBCOMPONENT_1. Для определенности будем считать, что мы формируем 
посадочное место для отечественного транзистора КТ315. Определим имя этого 
посадочного места по имени корпуса этого транзистора КТ-13. Для присвоения 
нового имени двойным щелчком левой кнопки мыши на имени 
PCBCOMPONENT_1 в панели PCB Library следует активизировать окно 
переименования компонента, указать имя КТ-13 и ввести описание (Description) – 
Footprint KT-13. 

3. Установить точку привязки графики в центр графического листа 
редактора. Для этого воспользоваться «горячими» клавишами  
(последовательно нажать J, R). С точки зрения трассировки печатного монтажа, 
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может оказаться предпочтительным располагать точку привязки не в центре 
графики, а на «ключевом» выводе компонента. Изменить положение точки 
привязки можно по команде главного меню Edit>Set Reference. 

Для размещения контактных площадок необходимо выполнить 
следующую последовательность действий: 

1. Активизировать команду главного меню Place>Pad (горячие клавиши P, P). 
Перед тем, как фиксировать плавающую за курсором контактную площадку 
(КП) на поле графического редактора, вызвать клавишей Tab диалог 
редактирования ее параметров. Открывается диалоговое окно свойств 
контактной площадки Pad (рис. 21). 

 

 
 

Рис. 21. Окно настройки параметров контактной площадки 
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2. В поле Location указать координаты КП (0, 0) на поле графического 
редактора.  

3. В поле Hole Information устанавить вид и размер отверстия КП. 
Возможны следующие варианты формы отверстия: 

• Round – круглое; 
• Square – квадратное; 
• Slot – щель. 
Выбрать круглое отверстие диаметром (Hole Size) 1,4 мм. Такой диаметр 

превышает на 0,4 мм ширину ленточного вывода транзисторов в корпусе КТ-13 
(требование ГОСТ 10317‒79, обусловленное необходимостью свободной 
установки выводов компонентов в монтажные отверстия КП). 

4. В поле Size and Shape выбрать форму и размеры площадки металлизации 
КП. Возможны следующие варианты формы: 

• Round – круглая, а при указании разных размеров по осям X и Y – 
овальная форма; 

• Rectangular – прямоугольная форма. 
5. В поле Properties назначить цоколевочное обозначение КП (Designator), 

сохранить принятый для схемного символа порядок обозначений выводов и 
обозначить вывод коллектора цифрой 1. Кроме цифровых, возможны 
буквенные (Alphabetic) и смешанные буквенно-цифровые обозначения выводов 
(Alphanumeric). 

6. Зафиксировать сформированную КП на поле графического редактора 
щелчком мыши или клавишей Enter. 

7. После фиксации на экране первой сформированной КП за курсором 
начинает перемещаться вторая. Зафиксировать вторую и третью КП (выводы 
базы и эмиттера) по разные стороны от вывода коллектора, по вертикали, с 
шагом 2,5 мм. Обозначения Designator при этом автоматически 
инкрементируются. 

8. Завершить установку КП щелчком правой кнопки мыши или клавишей 
Esc. Сохранить полученный результат командой File>Save. 

Черчение контуров корпуса компонента: 
1. Активизировать слой графического редактора Top Overlay, 

предназначенный для изображения контуров компонента в проекции, 
соответствующей способу установки его на плату. 

2. Активизировать команду главного меню Place>Line. Клавишей Tab 
вызвать диалог настройки параметров линии. Установить тип линии Solid – 
сплошная, толщину линии ‒ Small (0,254 мм). 

3. Клавишей G активизировать настройку сеток и выбрать активную сетку 
захвата Snap Grid c шагом 0,25 мм. 

4. Вычертить прямоугольник размером 3×7,5 мм с центром симметрии в 
точке расположения КП коллектора (средняя КП из трех). Затем прочертить 
линию фаски с отступом на 1 мм от левого края контура. 

Сохранить окончательный результат формирования ТПМ компонента 
командой File>Save. 
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В структуру контактной площадки входят две маски – Solder Mask – маска 
для защиты печатных проводников от воздействия влаги и перетекания припоя 
при монтаже и Paste Mask – маска, по форме окон в которой выполняется 
трафарет для нанесения припойной пасты перед пайкой поверхностно-
монтируемых (SMD) компонентов. Маски формируются на верхней и нижней 
сторонах платы. При настройке параметров КП есть возможность указать 
величину отступа краев отверстий в каждой из масок от края площадок 
металлизации на наружных слоях. Настройка выполняется в полях диалогового 
окна (см. рис. 21). 

В поле Paste Mask Expansion активизировать одну из двух опций – 
Expansion Value from Rules либо Specify Expansion Value. В первом случае 
значение отступа маски берется из правил, установленных для всего проекта в 
конфигурации редактора печатной платы командой Design>Rules. Во втором 
случае значение отступа назначается конструктором. 

Для создания более сложного посадочного места микросхемы лучше 
воспользоваться мастером. Для запуска мастера необходимо выполнить 
команду Tools>Component Wizard. На экране появится диалоговое окно мастера 
создания посадочных мест и после нажатия кнопки Next будет предложено 
выбрать тип корпуса и единиц измерения, как показано на рис. 22. 

 

 
 

Рис. 22. Окно мастера создания посадочных мест 
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Далее в пошаговом режиме необходимо: 
1. Определить размеры контактных площадок.  
2. Определить расположение контактных площадок относительно друг 

друга. 
3. Определить толщину линии контура. 
4. Задать количество контактных площадок в корпусе (в нашем случае ‒ 14). 
5. Дать название создаваемому корпусу. 
Закончить создание корпуса нажатием клавиши Finish. 
После завершения работы мастера необходимо сохранить библиотеку 

нажатием пиктограммы Save.  
Проверка корректности создания посадочных мест проводится аналогично 

данной процедуре в библиотеке символов, т. е. с помощью команды 
Report>Component Rule Check. При этом на экране появится окно, 
представленное на рис. 23. 

 

 
 

Рис. 23. Окно проверки посадочных мест 
 

Здесь программа проверяет дублирующиеся контактные площадки (Pads), 
примитивы (Primitives) и посадочные места (Footprint). Кроме этого, можно 
произвести проверку следующего: 

 ‒ Missing Pad Names – пропущенные названия контактных площадок, 
именно по ним автоматически будет проводиться сопоставление выводов 
символа и ножек микросхемы; 

‒ Offset Component Reference – смещение точки привязки, выдается 
сообщение в том случае, если привязка расположена не в проекции 
посадочного места; 

 ‒ Shorted Copper – пересечение объектов на слое металлизации; 
 ‒ Unconnected Copper – неподключенные объекты на слоях металлизации; 
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 ‒ Check All Components – проверяются все  компоненты, в противном 
случае проверка будет выполнена только для активного компонента. 

Поиск и исправление ошибок так же, как и в редакторе символов, 
выполняются вручную.  

 
1.3. Подключение моделей к схемному компоненту 

 
Присоединение моделей делает компонент пригодным к применению в 

сквозном проектировании функциональных узлов. При присоединении модели 
в среде редактора библиотеки схемных элементов (Schematic Library Editor) она 
оказывается связанной с компонентом, но ее данные не включаются в состав 
схемного компонента. Это означает, что связываемые модели должны быть 
доступны при формировании библиотек и при помещении компонента на лист 
схемы. Поиск моделей для подключения к компоненту происходит в 
следующей очередности: 

1) в библиотеках, включенных в дерево текущего проекта;  
2) в PCB-библиотеках (но не интегральных библиотеках), входящих в 

список библиотек, включенных в рабочую среду текущего проекта 
функционального узла; 

3) в любых библиотеках, путь к которым определен командой главного 
меню Project>Project Options. 

Будем считать, что топологическое посадочное место (ТПМ) для 
разрабатываемого нами компонента схемной библиотеки – NPN-транзистора 
КТ315 сформировано и сохранено в PCB-библиотеке PcbLib1.PcbLib под 
именем КТ-13 (название корпуса транзистора КТ315). 

Алгоритм подключения моделей к схемному компоненту: 
1. Щелчком левой кнопки мыши по кнопке Add в поле моделей плавающей 

панели SCH Library (рис. 24) активизировать процедуру присоединения модели. 
Открывается диалоговое окно Add New Model, в нашем случае следует указать 
тип модели – Footprint. 

2. Щелкнуть кнопку ОК. Открывается диалоговое окно PCB Model с 
пустыми полями. Кнопкой Browse открыть поиск PCB-библиотеки, 
содержащей интересующую нас топологическую модель. 

3. Открывается диалоговое окно просмотра библиотек Browse Libraries 
(рис. 25). Поскольку библиотека TPM.PcbLib, содержащая ТПМ КТ-13, 
включена в дерево проекта Transistor.LibPkg, поиск сразу обнаруживает его. Би
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Рис. 24. Окно подключения модели 
 
  

 
 

Рис. 25. Окно просмотра библиотек 
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В полях окна отображается имя библиотеки, имя ТПМ и его описание, а 

также графическое изображение контура и контактных площадок. Кнопкой ОК 
окно закрывается, а данные из его полей передаются в окно PCB Model             
(рис. 26). 

 

 
 

Рис. 26. Диалоговое окно выбора посадочного места 
 
4. Завершить процедуру подключения ТПМ кнопкой ОК. В поле моделей 

плавающей панели Sch Library отображаются сведения о подключенной модели 
ТПМ – его имя, тип и описание. 

 
1.4. Создание интегрированной библиотеки 

 
Для создания схемы достаточно иметь библиотеки компонентов в виде 

*.SchLib и *.PcbLib в структуре проекта, но в этом случае усложняется 
процедура структурирования библиотек и последующего оборота библиотек 
внутри предприятия. Файлы библиотек символов рекомендуется объединять в 
проект библиотек, который носит название интегрированной библиотеки. 
Использование интегрированной библиотеки имеет следующие преимущества: 
все символы, модели Spice и посадочные места хранятся в едином файле, 
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имеется возможность компиляции библиотеки, за счет чего достигается ее 
отладка. 

Для создания интегрированной библиотеки нужно: 
1. Выполнить команду File>New>Project>Integrated Library, после чего в 

структуре панели Project появится новый документ.  
2. Сохранить новый документ щелчком правой кнопки мыши и выбрав 

Save Project as в нужную директорию под именем Library. 
3. Добавить в структуру созданного проекта ранее созданные библиотеки 

путем их перемещения в дереве панели Project. В результате получим вид, как 
на рис. 27. Созданный файл имеет расширение *.LibPkg, а не *.IntLib, т. е. в 
настоящий момент мы имеем не саму интегрированную библиотеку, а файл 
заготовки, из которого будет сформирована интегрированная библиотека. 

 

 
 

Рис. 27. Создание интегрированной библиотеки 
 
4. Щелчком правой кнопки мыши на имени библиотечного проекта 

Library.LibPkg в плавающей панели Projects активизировать контекстное меню 
и указать в нем команду Compile Integrated Library Transistor.LibPkg. 

Если компиляция проходит без ошибок, формируется интегральная 
библиотека Library.IntLib. Библиотека автоматически сохраняется в 
подкаталоге ...\Project Outputs for Transistor\Transistor.IntLib того каталога, в 
котором находятся файлы-источники – библиотека схемных компонентов и 
библиотека ТПМ.  

Файлы описания моделей также копируются и компилируются в 
интегральную библиотеку. Новая интегральная библиотека включается в состав 
библиотек, подключенных к рабочему пространству Altium Designer, и ее 
компоненты могут в дальнейшем использоваться в сквозном проектировании 
радиоэлектронных функциональных узлов. 
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1.5. Использование существующих библиотек 
 
Для того чтобы получить возможность использования библиотек схемных 

элементов в редакторе электрической схемы или посадочных мест компонентов 
в редакторе печатной платы, библиотеки должны быть включены в рабочую 
среду Altium Designer. Процедура включения интегрированных библиотек в 
рабочую среду программы следующая: 

1. Активизировать закладку Libraries на краю рабочего окна программы 
или выполнить последовательность команд в главном меню: View>Workspace 
Panels>System>Libraries. Активизируется плавающая панель Libraries (рис. 28). 

 

 
 

Рис. 28. Плавающая панель Libraries 
 

В полях этой панели представлено имя одной из ранее подключенных 
библиотек, состав ее компонентов и их краткое описание, условно-графическое 
обозначение схемного элемента, на который указывает курсор селекции, 
сведения о модели компонента: в простейшем случае это имя топологического 
посадочного места (ТПМ) и библиотеки, в которой ТПМ хранится, а также его 
графическое изображение. 

Панель может растягиваться или сжиматься обычным для окон MS 
Windows способом, перемещаться по экрану и «приклеиваться» к краям 
рабочего графического окна программы. 
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2. Для присоединения недостающих библиотек щелчком по кнопке 
Libraries в верхней части панели активизировать окно со списком 
установленных библиотек Installed Libraries (рис. 29). 

 

 
 

Рис. 29. Окно подключенных и активных библиотек 
 
3. Кнопкой Install активизировать стандартный диалог поиска библиотек 

для присоединения их к рабочей среде программы. Найденные библиотеки 
подключить нажатием кнопки Open в окне поиска. 

4. Кнопкой Close в окне (см. рис. 29) завершить подключение библиотек. 
Если при этом было открыто окно текущего проекта электрической схемы, 
выбранные символы подключенных библиотек могут вызываться кнопкой 
Place<Имя_компонента> на поле проектируемой схемы. 

Для исключения ненужных в проекте библиотек вызвать, аналогично п. 2, 
диалоговое окно (см. рис. 29) и указать в нем ненужные библиотеки и удалить 
их из списка кнопкой Remove. 

Altium Designer располагает эффективными средствами поиска нужного 
компонента в библиотеках, когда путь к нему и имя библиотеки неизвестно. 
Поиск выполняется следующим образом: 

1. Активизировать поиск кнопкой Search в панели Libraries. Открывается 
диалоговое окно Libraries Search (рис. 30). Возможно два вида поиска: 
упрощенный (Simple) и усовершенствованный (Advanced). 
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Рис. 30. Диалоговое окно поиска компонентов 
 
2. В верхнем, текстовом поле окна указать «маску поиска» – написать 

группу символов, которая наверняка является частью имени искомого 
компонента. Звездочки слева и справа от написанных символов расширяют 
поиск на все имена во всех библиотеках, в том числе и неподключенных, 
частью которых является указанная последовательность символов. 

  3. В поле Scope указать в выпадающем списке Search in тип объектов 
поиска – библиотечные компоненты, посадочные места, трехмерные модели 
или компоненты из баз данных. Область поиска библиотечного компонента 
следующая: 

• Available Libraries – поиск в доступных библиотеках; 
• Libraries on Path – поиск по заданному пути. 
В последнем случае в поле Path указать путь, по которому следует искать 

библиотеки. 
4. Воспользовавшись улучшенным поиском, кнопкой Helper (помощник) 

может быть активизирована функция расширения маски поиска – указаны 
дополнительные признаки, их логическое сочетание, параметры и/или 
арифметические операции над ними и т. д.  

5. Кнопкой Search начать поиск компонента. Результаты поиска 
отображаются в плавающей панели Libraries в списке Query Results. Значки 
найденных компонентов отображаются в поле просмотра. Имя выбранного 
компонента появляется на кнопке Place в диалоговом окне. Щелчком на Place 
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компонент, в зависимости от выполняемой стадии проектирования, выносится 
на поле графического листа схемы или печатной платы, где может быть 
зафиксировано нужное число его копий. 

 
1.6. Порядок выполнения работы 

 
Порядок выполнения лабораторной работы следующий: 
1. Получить у преподавателя вариант индивидуального задания. 
2. Выполнить создание УГО заданных односекционного и многосек-

ционного компонентов. 
3. Выполнить создание посадочных мест заданных компонентов для двух 

вариантов установки: поверхностный монтаж и монтаж в отверстия. 
4. Создать интегрированную библиотеку, содержащую заданные компо-

ненты. 
5. Выполнить отчет по результатам выполнения лабораторной работы. 
 

1.7. Содержание отчета 
 

Отчет по лабораторной работе должен содержать: 
1. Цель работы. 
2. Краткие теоретические сведения. 
3. Последовательность выполнения работы в виде следующих скриншотов 

с описанием: 
3.1. Настройки единиц измерения. 
3.2. Настройки сетки и параметров листа. 
3.3. Создания нового и/или переименования компонента. 
3.4. Всех частей компонента с открытой нумерацией выводов. 
3.5. Настройки любого вывода типа Passive. 
3.6. Настройки вывода земли GND. 
3.7. Настройки вывода питания VCC. 
3.8. Таблицы распиновки и/или эквивалентности выводов. 
3.9. Всех окон Component Wizard. 
3.10. Подключения посадочного места к УГО. 
3.11. Скомпилированной интегрированной библиотеки (ИБ) IntLib. 
3.12. Проверки компонента на ошибки Rule Check Component. 
3.13. Окна свойств компонента. 
3.14. Библиотеки с оригинальным названием в окне подключенных и 

активных библиотек. 
4. Выводы. 
 

1.8. Контрольные вопросы 
 

1. Каковы основные принципы настройки рабочей среды при 
проектировании компонентов электрических схем? 
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2. В какой последовательности осуществляется формирование УГО 
компонентов? 

3. Каковы правила настройки электрических выводов и подключенных к 
ним цепей? 

4. В чем заключаются специфические настройки при создании 
многосекционных компонентов? 

5. Каким образом проводится установка эквивалентности (сваппирования) 
выводов компонентов? 

6. Как осуществляется проверка библиотек компонентов? 
7. Каковы основные принципы создания посадочных мест компонентов в 

ручном режиме? 
8. Как происходит создание посадочных мест с помощью мастера? 
9. Каковы основные настройки контактных площадок? 
10. Как осуществляется проверка корректности создания посадочных 

мест? 
11. Каковы основные принципы подключения моделей к схемным 

компонентам? 
12. Каковы основные принципы создания и организации интегрированных 

библиотек? 
13. Как настраиваются правила поиска компонентов в библиотеках? 
14. Каковы принципы использования и активации интегрированных 

библиотек? 
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Лабораторная работа №2 
 

Разработка электрических принципиальных схем  
в среде Altium Designer 

 
Цель работы: изучить основные принципы разработки и настройки 

электрических схем в среде Altium Designer; разработать, собрать, настроить и 
подготовить для передачи на печатную плату электрическую схему реального 
устройства. 

 
2.1. Настройка рабочей среды и проекта 

 
При реализации проектов печатных плат работа начинается с 

формирования идеи разработчика в виде принципиальной схемы. 
Формирование новой электрической схемы начинается с создания нового файла 
проекта и листа схемы командами File>New>Project>PCB Project и 
File>New>Schematic. После создания новых документов их следует сразу же 
сохранять. Для сохранения проекта выполняется File>Save Project As, а для 
схемы – File>Save. Например, присвоим проекту и схеме название Study. В 
результате в окне документов появляется лист схемы (по умолчанию    формат 
А4), а в панели Project будет отражена структура проекта, как показано на рис. 31. 

 

 
 

Рис. 31. Структура проекта 
 

Настройка редактора схем 
Настройки в AD можно разделить на глобальные, относящиеся ко всем 

документам, и локальные, относящиеся только к текущему документу. 
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Некоторые из настроек дублируются в двух местах (как, например, сетки и 
единицы измерения) и отличаются только областью применения. 

Настройки текущего документа настраиваются на вкладке 
Design>Document Options (рис. 32). 

 

 
 

Рис. 32. Настройки текущего документа 
 
Для начала во вкладке Units нужно указать метрическую  систему единиц 

измерения, при этом настройка будет действовать только на открытый 
документ. 

В поле Template указать имя текущей форматки, в поле Standard Style 
выбрать размер листа из стандартных. 

Поле Options:  
• Orientation – можно выбрать ориентацию листа из двух значений: 

Landscape (альбомная) и Portrait (книжная); 
• Title Blok – показывать стандартную рамку листа, которая может 

использоваться совместно с пользовательской, что не совсем удобно; 
• Show Reference Zone – показывать зоны разметки, в виде буквенно-

цифровых обозначений по границам листа; 
• Show Border – показывать границы листа; 
• Show Template Graphics – показывать стандартный штамп (форматку); 
• Border color и Sheet color – можно выбрать цвет границы листа и цвет 

листа. 
В поле Grids (Сетки) выбрать шаг сетки и видимость сетки. Electrical Grid 

(электрическая сетка) – область вокруг вывода компонента, за которую 
«цепляется» цепь при соединении компонентов. Значение данного параметра 
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должно быть в два раза меньше чем минимальный шаг расположения выводов 
УГО, чтобы области двух соседних выводов не пересекались между собой. 
Нажатием кнопки ОК подтвердить выбранные настройки. Кнопка Change 
System Font (Поменять системный шрифт) используется для надписей, 
привязанных к некоторым объектам по умолчанию (например, имя (Pin Name) 
и номер (Pin Des) вывода, имя порта). Изменив этот параметр на данной 
вкладке, величина указанных надписей изменится во всем документе. 

В поле пользовательских настроек Custom Style активизировать настройку 
пользовательского формата – опция Use Custom Style и назначить размеры 
листа по горизонтали и по вертикали. При этом необходимо руководствоваться 
следующим: зонная разметка должна быть сохранена для того, чтобы 
впоследствии в схеме была возможность перенумерации позиционных 
обозначений. 

Глобальные настройки редактора находятся в меню 
DXP>Preferences>Schematic (рис. 33). Для начального ознакомления оставить 
все параметры по умолчанию. 

  

 
 

Рис. 33. Окно глобальных настроек редактора AD 
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2.2. Создание схемы 
 
Создадим схему мультивибратора, представленную на рис. 34. 
 

 
 

Рис. 34. Схема электрическая принципиальная мультивибратора 
 
Начинать следует с добавления компонента в схему через главное меню 

Place>Part… (горячие клавиши P, P). 
Здесь Placement Type – From Standard Libraries оставить, т. к. будут 

использоваться встроенные библиотеки. Нажать кнопку с тремя точками, чтобы 
выбрать библиотеку. 

В поставке AD идут две стандартные библиотеки компонентов: 
Miscellaneous Devices.IntLib и Miscellaneous Connectors.IntLib. Это 
интегрированные библиотеки, т. е. содержащие и символы, и посадочные 
места. Если пакет установлен по умолчанию, то они находятся по адресу 
C:Programs\\Files\Altium\Library.  

Появляется окно выбора библиотеки компонентов (рис. 35). Сверху окна 
видно наименование библиотеки, появляется список компонентов, справа 
символ и посадочное место. Здесь выбрать подходящий компонент (2N3904) и 
нажать ОК.  

 
Би
бл
ио
те
ка

 БГ
УИ
Р



47 
 

 
 

Рис. 35. Окно выбора библиотеки компонентов 
 

Далее необходимо вернуться в окно выбора компонентов (рис. 36). Здесь 
уже заполнены все поля и есть возможность изменить некоторые параметры, 
например позиционное обозначение или тип посадочного места. Знак вопроса в 
позиционном обозначении – служебный символ, необходим для 
автоматической нумерации. Вместо него можно сразу поставить номер, но не 
нужно. 

 

 
 

Рис. 36. Окно выбора компонента 
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Нажать ОК. После выбора компонента в библиотеке он «прикрепляется» к 
курсору. Сейчас можно вызвать окно свойств компонента, нажав клавишу Tab, 
однако, если изменить его свойства, последующие компоненты будут их 
наследовать до выбора следующего.  

Установка компонента производится нажатием левой кнопки мыши в 
нужном месте рабочего поля. После установки компонент по прежнему 
«прикреплен» к курсору и есть возможность установить еще один такой же. Но 
в схеме требуется его зеркальная копия, поэтому следует нажать клавишу X на 
клавиатуре. Установить компонент. 

Так как больше транзисторы не нужны, следует перейти к выбору 
компонентов в библиотеке, для чего нажать правую кнопку мыши и вернуться в 
окно выбора компонентов. Выбрать резистор и установить горизонтально. 
Следующий нужно повернуть на 90°, для этого нажать клавишу пробел (рис. 37). 
Повторить операцию для конденсаторов и разъема, который находится в другой 
библиотеке. 

 

 
 

Рис. 37.  Построение схемы мультивибратора 
 

Закрыть окно выбора компонентов можно клавишей Esc. Передвигать 
рабочее поле можно, «зацепив» его правой кнопкой мыши за свободное от 
элементов место, но этот режим не работает, если был выбран компонент. В 
этом случае можно подтянуть курсор с прикрепленным к нему компонентом к 
нужному краю экрана и рабочее поле плавно передвинется. Масштабируется 
изображение стандартно – колесиком мыши при нажатой клавише Ctrl. 
Компоненты можно передвинуть, «зацепив» их левой кнопкой мыши, при этом 
их можно повернуть и сделать зеркальными.  
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Для прокладки проводников в главном меню выполнить команду 
Place>Wire. Подвести курсор к выводу компонента, где он подсвечивается 
диагональным красным крестом, что означает возможность сделать 
соединение, как показано на рис. 38. 

 

 
 

Рис. 38. Прокладка проводников 
 
Далее нажать левую кнопку мыши и тянуть проводник до следующего 

вывода. Если проводник тянется не так, как хотелось бы, его следует повернуть 
пробелом, так же как и компонент. Сменить угол прокладки проводника с 90º 
на 45º можно сочетанием клавиш Shift + пробел. Если на одной линии 
прокладки стоят несколько компонентов, то проводник можно тянуть до 
следующего, а предыдущий автоматически «прицепится» к прокладываемому 
проводнику. 

По умолчанию при попытке перемещения проводника его сегмент (от 
одного угла или вывода компонента до другого) «отрывается» от компонентов 
и, если он изначально рисовался как сегмент, проводника. Для того чтобы 
проводник или компонент тянули за собой проводники, перед перемещением 
следует нажать клавишу Ctrl и удерживать ее во время перемещения. 

Символ Земли добавить через главное меню по команде  Place>Power Port, 
который автоматически именует присоединенную цепь. Добавить имя для 
других цепей можно, поставив ярлык через Главное меню по команде Place>Net 
Label. 

При любом внесении изменений необходимо постоянно сохраняться. 
После каждого нажатия кнопки Save система создает резервную копию схемы 
или платы, архивирует ее и складывает в папку History папки проекта. 
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Позиционные обозначения AD позволяет проставить автоматически. Но 
при выполнении лабораторной работы позиционные обозначения следует 
проставить методом ECO (Engineering Change Order). С помощью ECO можно 
отследить достаточно много ошибок, причем до производства каких-либо 
действий. На этом этапе также можно сформировать отчеты для более 
подробного изучения. В главном меню выполнить команду  Tools>Annotate 
Schematics. Откроется окно расстановки позиционных обозначений (рис. 39). 

 

 
 

Рис. 39. Окно расстановки позиционных обозначений 
 
Сначала необходимо выбрать порядок расстановки (отмечен стрелкой) – 

Down Then Across, картинка под списком наглядно показывает процесс. Далее 
нажать Update Changes List. Всплывающее окно информации (рис. 40) 
показывает, сколько позиционных обозначений обновлено. 

 

 
 

Рис. 40. Окно информации о внесенных изменениях 
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Теперь в окне справа можно видеть изменения в списке – колонка 
Proposed. Если все устраивает, а оно устраивает, нажать Accept Changes (create 
ECO). Только сейчас изменения вносятся в схему. Открывается окно со 
списком изменений, которые должны быть внесены в схему. 

Нажать кнопку Validate Changes, и система начинает проверять 
возможность внесения изменений без ошибок. После нажать кнопку Execute 
Changes. В результате открывается окно, представленное на рис. 41.  

 

 
 

Рис. 41. Окно проверки принятых изменений 
 

По умолчанию сортировка компонентов производится по полю Comment, 
но правило можно изменить. В процессе проставления позиционных 
обозначений необходимо обратить внимание на количество обновленных 
позиционных обозначений относительно количества компонентов в схеме. Если 
у одного или нескольких компонентов уже проставлены позиционные 
обозначения, то они обновлены не будут. Поэтому некоторые позиционные 
обозначения можно проставить вручную. В случае необходимости обновления 
всех позиционных обозначений, их необходимо предварительно сбросить. Эта 
операция повторяет аннотацию, только вместо кнопки Update Changes List 
следует нажать Reset All (см. рис. 39). 

В результате у каждого компонента видны три атрибута: позиционное 
обозначение, комментарий, номинал (см. рис. 34). У транзисторов по понятной 
причине номинал отсутствует. Изменить атрибуты можно прямо на схеме. 
Двойной щелчок левой кнопки мыши на номинале вызовет окно свойств 
атрибута. Все атрибуты для компонента можно изменить в окне свойств 
компонента, дважды щелкнув левой кнопкой мыши на нем (рис. 42). Основные 
атрибуты указаны стрелками ‒ это позиционное обозначение и комментарий с 
флажками видимости, номинал, посадочное место. 
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Рис. 42. Окно свойств компонента 
 

Можно изменить необходимые атрибуты. Далее, для красоты, можно их 
подвигать. Однако для этого необходимо уменьшить шаг сетки, для чего 
следует нажать View>Grids>Set Snap Grid. В окне выбора шага сетки изменить 
значение на 5. Предыдущее значение шага сетки осталось в стеке, и межу ним и 
новым значением можно переключаться клавишей G. Текущее значение 
выводится в строке состояния в левом нижнем углу. Для более точной 
установки атрибутов можно «цеплять» их мышкой и устанавливать на нужное 
место. После этого можно скрыть комментарии у резисторов и конденсаторов 
через окно свойств и готовую схему сохранить. Для больших схем на помощь 
приходит  инспектор. Это инструмент для правки групп параметров. 

Практически все операции в AD выполняются с помощью запросов. 
Инспектор ‒ это, по сути, построитель запросов. Параметры в нем можно 
задавать вручную или можно воспользоваться мастером. Отдельно он 
вызывается клавишей F11 (рис. 43) или можно выделить на схеме атрибут, 
щелкнуть на нем правой кнопкой мыши и выбрать Find Similar Objects. 
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Рис. 43. Вызов окна мастера ввода параметров 
 

В результате откроется окно – мастер ввода параметров (рис. 44), в 
котором можно выбрать параметры запроса, точнее изменить их по 
необходимости. 

 

 
 

Рис. 44. Мастер ввода параметров 
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При выполнении лабораторной работы необходимо изменить  параметры 
совпадения в Object Specific Value и Object Specific Parameter Name с Any 
(Любой) на Same (Одинаковый). То есть получится, что были выбраны все 
комментарии с именем Res1 ‒ ставим галочку Select Matching (Выбрать все 
подходящие). Далее нажать Apply (Применить), на схему будет «наложена» 
маска, подсвеченными останутся только комментарии для резисторов (рис. 45). 
Проверить, чтобы стояла галочка Run Inspector. 

 

 
 

Рис. 45. Подсвеченные комментарии резисторов 
 

Если на схеме все выделилось, то нажать ОК. Запустится SCH Inspector 
(рис. 46). Здесь поставить галочку Graphical>Hide и посмотреть на результат.  

 

 
 

Рис. 46. Окно SCH Inspector 
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Закрыть инспектор и в правом нижнем углу программы нажать кнопку 
Clear, чтобы отменить маскирование (рис. 47). 

 
 

 
 

Рис. 47. Кнопка маскирования 
 

Схема готова, и ее можно передать на плату. Но для подготовки схемы 
использовалась интегрированная библиотека, а изменение/добавление 
компонентов библиотеки не допускается, что ограничивает возможности 
редактирования схемы. Чтобы обойти это ограничение, необходимо создать 
свои библиотеки. 

Нужно отметить, что в схеме содержится полная информация о 
компоненте и ее можно получить из схемы. Таким же путем возможно 
изменять компоненты прямо на схеме, например, назначение и имена выводов, 
ссылку на посадочное место и др., но это придется делать для каждого 
компонента отдельно. Но многие параметры (например, графическое 
изображение) изменить на схеме нельзя. Поэтому необходимо создать свои 
библиотеки. 

Для этого можно воспользоваться схемой, как заготовкой будущей 
библиотеки. В оболочке AD может быть открыто несколько документов. Все 
действия производятся в текущем, в зависимости от этого меняется состав 
главного меню и панелей. В главном меню выбрать Design>Make Schematic 
Library. Извлекаются символы из схемы, и создается библиотека (схемная). 
Появляется боковая панель – SCH Library, и открывается первый по списку 
символ для редактирования. Окно информации подсказывает, сколько 
извлечено символов из схемы (рис. 48). 
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Рис. 48. Создание библиотеки компонентов из схемы 
 
Но библиотека, как таковая, еще не прописана в проекте и связи еще не 

обновлены. Об этом косвенно говорит отсутствие вида посадочного места в 
окне просмотра (см. рис. 48). 

Теперь необходимо вернуться к дереву проектов. Переключение между 
открытыми панелями осуществляется с помощью закладок (рис. 49). В дереве 
проекта появилась библиотека символов. Сохранить библиотеку аналогично 
сохранению проекта и схемы. 

 

 
 

Рис. 49. Переключение документов 
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ОБЯЗАТЕЛЬНО после каждого внесения изменений в библиотеку ее 
нужно сохранить, только после этого изменения вступают в силу. 
Возвращаемся к панели SCH Library. Заменим компоненты в схеме на только 
что созданные. Для этого щелкнуть правой кнопкой мыши на названии 
компонента в боковой панели и выбрать в контекстном меню Update Schematic 
Sheets (рис. 50). 

 

 
 

Рис. 50. Обновление компонентов на схеме 
 

Информационное окно сообщит о количестве замененных компонентов, 
здесь не лишним будет проверить, все ли обновилось и на тех ли схемах. 

Изменения вносятся в открытые документы. Заменяются компоненты с 
совпадающими именами. 

Проверить результат можно с помощью инспектора (вызывается клавишей 
F11). Выделить компонент и посмотреть в инспекторе поле Object Specific 
Library (рис. 51), в нем должно быть имя вновь созданной библиотеки. 
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Рис. 51. SCH Inspector 
 

Так как в схеме были заменены все элементы из интегрированной 
библиотеки на элементы из схемной, то это подразумевает поиск библиотеки 
посадочных мест, которая еще не создана. 

В окне библиотеки открыть панель SCH Library. Дважды щелкнуть левой 
кнопкой мыши по названию элемента. В окне свойств посмотреть на окно 
предварительного просмотра посадочного места. В нем пусто, что косвенно 
говорит о проблеме с поиском посадочного места. Выделить имя посадочного 
места (рис. 52) и нажать кнопку Edit. В окне выбора посадочного места снова 
посмотреть в окно предварительного просмотра (рис. 53). 

Изменить состояние переключателя PCB Library с Use footprint from in на 
Any, тем самым разрешив поиск подходящего посадочного места во всех 
подключенных библиотеках. И, несмотря на пропавшее изображение 
посадочного места, закрыть окно. Повторить действия для остальных 
элементов. Сохранить библиотеку. Обновить компоненты в схеме. 
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Рис. 52. Окно свойств библиотеки компонентов 
 

 
 

Рис. 53. Окно выбора посадочного места 
 
Горячие клавиши: 
• Space – поворот компонента или угла; 
• Shift + Space – смена угла прокладки трассы или цепи; 
• X – зеркальное отображение компонента; 
• G – переключение между сетками перемещения; 
• F11 – вызов инспектора; 
• Ctrl + Mouse Wheel – масштабирование изображения. 
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Нажатая клавиша Shift позволяет выделить несколько компонентов. 
Нажатая клавиша Ctrl позволяет переместить компонент без отрыва от 

цепи или трассы. 
Клавиша Tab при установке компонента или прокладке проводника 

вызывает окно свойств. 
 

2.3. Проверка схемы и исправление ошибок 
 
Заключительным этапом разработки схемы является компиляция проекта. 

В процессе компиляции окончательно выстраивается логическая структура 
проекта. Выявляются ошибки, допущенные при составлении электрической 
принципиальной схемы. 

Для простого одноуровневого проекта с несложной однолистовой схемой 
может оказаться достаточным визуальный контроль в ходе и по окончании 
формирования документа. В сложном иерархическом проекте ошибки могут 
ускользнуть от визуального контроля. Чтобы этого не происходило, в Altium 
Designer заложена развитая система контроля ошибок. 

Перед компиляцией следует выполнить настройки функций контроля. 
Настройки выполняются в диалоге, активизируемом командой главного меню 
Project>Document Options. Открывается диалоговое окно Options for 
Project<имя проекта>.PrjPcb (рис. 54) с десятью панелями-вкладками, на 
которых перечислены все возможные признаки, по которым выявляются 
ошибки проекта. 

 

 
 

Рис. 54. Окно настройки опций для PCB-проекта 

Би
бл
ио
те
ка

 БГ
УИ
Р



61 
 

В плане компиляции нас больше всего могут интересовать настройки, 
призванные выявить нарушения правил соединения компонентов линиями 
электрической связи и соответствие обозначений цепей, портов, соединителей 
листов в случае многолистового проекта. 

На вкладке Error Reporting назначается характер реакции программы на 
обнаруженные нарушения: 

• No Report – не включать обнаруженное нарушение в отчет; 
• Warning – вывести предупреждение; 
• Error – вывести сообщение об ошибке; 
• Fatal Error – вывести сообщение о фатальной ошибке, при которой 

невозможно выполнение операции. 
Чтобы установить уровень всех нарушений в значение Error следует 

щелкнуть правой кнопкой мыши в любом месте окна и выбрать All Error. 
 Все типы нарушений на вкладке Error Reporting разбиты на группы по 

отношению к определенному типу объектов. Варианты их отображения и 
рекомендуемые настройки: 

1. Violations Associated with Buses ‒ предупреждения, связанные с шинами. 
2. Violations Associated with Components – предупреждения, связанные с 

компонентами. 
3. Violations Associated with Configuration Constrains – предупреждения, 

связанные с ограничениями конфигурации. 
4. Violations Associated with Documents – предупреждения, связанные с 

документами. 
5. Violations Associated with Harnesses – предупреждения, связанные со 

жгутами. 
6. Violations Associated with Nets – предупреждения, связанные с цепями. 
7. Violations Associated with Others, Violations Associated with Parameters – 

предупреждения, связанные с параметрами и др.    
На вкладке Connection Matrix (рис. 55) определяются правила проверки 

электрических соединений схемы и назначается уровень реакции программы на 
различные виды ошибок, такие как соединение выхода с выходом, выхода с 
питанием, двунаправленного вывода компонента с выходным и т. п. На 
пересечении столбцов и строк матрицы стоят цветные метки, обозначающие 
реакцию программы на соответствующее соединение, обнаруженное при 
проверке схемы. Выбирая соответствующую метку, можно назначить один из 
четырех уровней реакции – отсутствие реакции (если нет ошибки), 
предупреждение, сообщение об ошибке, фатальная ошибка. Каждому уровню 
соответствует свой цвет – от зеленого до красного. 
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Рис. 55.  Вкладка Connection Matrix 
 
Вкладка Class Generation отражает правила формирования классов цепей и 

компонентов. При желании можно отключить формирование комнат и классов 
компонентов согласно подлистам схемы. 

На вкладке Comparator настраиваются правила проверки соответствия 
имен одинаковых объектов, цепей на листах многолистового проекта и целого 
ряда других возможных ошибок. 

Вкладка ECO Generation отражает настройки отчета о перечне изменений. 
Выбираются те изменения, которые следует включить в отчет. По умолчанию 
включены все опции (изменять эти данные нецелесообразно). 

Вкладка Options – группа дополнительных настроек проекта. Здесь 
задаются директории сохранения отчета о компиляции, компарации и т. д. В 
группе Output Options выбираются действия, которые следует применить после 
выполнения процесса компиляции. 

Вкладка Multi Channel задает порядок нумерации компонентов при 
реализации многоканальных и иерархических проектов. 

Во вкладке Default Prints отражаются настройки распечатки документации 
проекта. 

Вкладка Search Puths показывает расположение библиотек, в которых по 
умолчанию будет проводиться поиск компонентов. 

Вкладка Parameters отражает параметры проекта, которые могут быть 
использованы для составления текстовых надписей, являющихся общими для 
всех документов проекта. 

Би
бл
ио
те
ка

 БГ
УИ
Р



63 
 

Вкладка Device Sheets отражает расположение директорий, содержащих 
схемы, которые используются в проекте в качестве готовых решений (подсхем) 
в иерархии нижних уровней.  

Компиляция проекта выполняется по команде главного меню Project> 
Compile Document <имя_схемы>.SchDoc. Если при компиляции обнаружены 
ошибки, сообщения об ошибках выводятся на панель Messages. В этом случае 
следует проанализировать сообщения, внести в схемный документ 
необходимые изменения и повторить компиляцию проекта. Схемный документ, 
откомпилированный без ошибок, может быть передан на проектирование 
печатной платы. 

 
2.4. Порядок выполнения работы 

 
Порядок выполнения лабораторной работы следующий: 
1. Получить у преподавателя вариант индивидуального задания. 
2. Осуществить сборку электрической схемы задания. 
3. Пронумеровать собранную схему и проверить на ошибки. 
4. По результатам выполнения работы оформить отчет. 
 

2.5. Содержание отчета 
 

Отчет по лабораторной работе должен содержать: 
1. Цель работы. 
2. Краткие теоретические сведения. 
3. Последовательность выполнения лабораторной работы в виде 

следующих скриншотов: 
3.1. Собранной электрической схемы без расстановки позиционных 

обозначений. 
3.2. Annotate Schematic. 
3.3. Финального варианта схемы. 

4. Выводы. 
 

2.6. Контрольные вопросы 
 
1. Каковы основные принципы настройки рабочей среды для разработки 

электрических схем? 
2. Каковы общие принципы поиска и установки компонентов 

электрических схем? 
3. Каким образом происходит размещение различных видов электрических 

цепей на схеме? 
4. Каковы «горячие» клавиши для работы с компонентами и цепями в 

редакторе Schematic? 
5. Как происходит автоматическая расстановка позиционных обозначений? 
6. Каковы принципы работы с SCH Inspector? 
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7. Как осуществляется работа с библиотеками на этапе сборки 
электрических схем? 

8. Как осуществляется проверка электрической схемы и исправление 
ошибок? 

9. Каковы общие принципы подготовки электрических схем для передачи 
на печатную плату? 
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Лабораторная работа №3 
 

Разработка проекта печатной платы 
 
Цель работы: изучить основные принципы разработки печатных плат в 

среде Altium Dеsigner; разработать проект печатной платы на базе 
электрической схемы и интегрированных библиотек. 

 
3.1. Создание заготовки печатной платы 

 
При разработке нового проекта необходимо определить геометрию и 

структуру слоев заготовки печатной платы. Первый шаг по формированию 
структуры заготовки целесообразно выполнить пользуясь встроенной в Altium 
Designer функцией «Мастер подсказки» PCB Board Wizard. Рассмотрим 
процедуру по шагам:  

1. Активизировать плавающую панель меню Files. Для этого в главном 
меню программы активизировать цепочку команд: File>New>Other>Files Panel.  

2. В поле New from template панели Files  активизировать  последнюю 
команду: PCB Board Wizard. Открывается диалог настройки параметров 
заготовки печатной платы. Настройка выполняется в несколько шагов, на  
каждом из которых в диалоговом окне PCB Board Wizard предлагается  
выполнить ряд установок. Последовательный переход с шага на шаг и обратно 
выполняется по щелчкам на кнопках Next и Back. 

3. На шаге Choose Board Units определить систему единиц измерения, 
указать Metric (рис. 56).   

 

 
 

Рис. 56. Определение системы координат 
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4. На шаге Choose Board Profiles открывается список из 60 возможных 
вариантов  готовой  заготовки.  Сюда  входят  несколько  типоразмеров 
«Европлаты»,  несколько  вариантов  адаптера PCI-шины  персонального IBM 
компьютера и много других. Для формирования  заготовки из ряда  
типоразмеров УБНК1 по ГОСТ 26765.12‒86 выбрать вариант пользовательских 
установок – Custom (рис. 57).  

 

 
 

Рис. 57. Определение типа печатной платы 
 
5. На шаге Choose Board Details (рис. 58) указываются:  
•  форма  платы –  прямоугольная (Rectangular),  круглая (Сircular) или  

произвольная (Custom), ограниченная  прямоугольными  отрезками и/или 
дугами;  

•   размеры платы по горизонтали и по вертикали – Board Size; 
•  выбирается  слой  для  размещения  размерных  линий –  из  числа 

«механических» слоев – по умолчанию Mechanical Layer 1; 
•  толщина (ширина)  линии,  ограничивающей  контур  платы Boundary 

Track Width;  
•  толщина размерных линий – Dimension Line Width; 
•  расстояние от края платы до ограничительной линии  зоны  трассировки 

печати – Keep Out Distance From Board Edge.  

Би
бл
ио
те
ка

 БГ
УИ
Р



67 
 

 
 

Рис. 58. Определение пользовательских настроек печатной платы 
 
6. На шаге Choose Board Layers (рис. 59) указывается число сигнальных 

(Signal Layers) и экранных слоев печатной платы (Power Planes). Необходимые 
значения назначаются в полях просмотра диалогового окна. 

 

 
 

Рис. 59. Послойное определение платы 
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 7. На следующем шаге, Choose Via Style (рис. 60), предлагается выбрать 
один из двух стилей – только сквозные (Thruhole Vias only) или только слепые 
и захороненные переходные отверстия (Blind and Buried Vias only). В 
диалоговом окне показывается фрагмент разреза платы для выбранного случая.  

 

 
 

Рис. 60. Определение типа переходных отверстий 
 
8. На следующем шаге, Choose Component and Routing Technologies (рис. 61), 

предлагается выбрать преобладающий тип компонентов – поверхностно-
монтируемые (Surface-mount Components) или монтируемые штырями в  
отверстия (Through-hole Components).   

Для поверхностно-монтируемых (SMT) предлагается указать правила 
установки компонентов на одной или на обеих сторонах платы. Для штыревых 
компонентов предлагается указать, сколько печатных проводников может быть 
проведено между двумя переходными (монтажными)  отверстиями,  
расположенными  с шагом 2,54 мм, – один,  два или три.  
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Рис. 61. Определение преобладающего типа компонентов                                     
на печатной плате 

 
9. На следующем шаге, Choose Default Track and Via sizes (рис. 62), в 

диалоговом окне  приводятся  минимальные  значения  ширины  проводника,  
зазоров   и диаметры контактной площадки и отверстия. 

 

 
 

Рис. 62. Настройка базовых конструктивных параметров печатной платы 
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После выполнения всех этих действий программа переходит в финишное 
окно и предлагает завершить работу по формированию заготовки щелчком по 
кнопке Finish. 

Теперь необходимо указать области, запрещенные для трассировки 
(отверстия, надписи). Для этого следует перейти к слою Keep-Out Layer и 
обозначить эти области. Готовый результат приведен на рис. 63. 

Необходимо сохранить полученный результат. 
 

 
Рис. 63. Запрещенные для трассировки области 

 
Передача схемной  информации  на  печатную  плату  производится  по  

команде Design>Update PCB Document <имя_проекта>.PcbDoc. После 
выполнения команды открывается диалог внесения изменений Engineering 
Changes Order (рис. 64).  

Далее необходимо  кнопкой Validate Changes  активизировать проверку 
правильности  вносимых  изменений. Если  при  этом не выявлено ошибок, в 
поле Status появляются знаки-галочки, свидетельствующие о завершении 
операции  без  ошибок. Строки  списка,  в   которых  обнаружены  
несоответствия (например, не найдено топологическое посадочное место), 
помечаются красной меткой с крестиком. В этом случае необходимо  
просмотреть  сообщения об ошибках на панели Messages и устранить 
несоответствия. Для передачи информации на печатную плату нажать Execute 
Changes. При успешной передаче информации на печатную плату закрыть окно 
редактора. 

 

Би
бл
ио
те
ка

 БГ
УИ
Р



71 
 

 
 

Рис. 64. Окно Engineering Changes Order 
 
 Затем открыть файл платы активного проекта, и в окне  графического  

редактора  печатной  платы  рядом  с  заготовленным  ранее  контуром платы  
изображаются  топологические посадочные места  компонентов,  связанные  
линиями  электрических  связей. По  умолчанию  программа  заключает  
компоненты  и связи проекта в прямоугольную область Room (комнату). Вся 
эта область вместе с заключенными в ней компонентами при указании на нее 
курсором и нажатии левой кнопки мыши перемещается  за курсором по  экрану  
графического редактора, в том числе она может быть помещена в пределы 
контура печатной платы.  

 Теперь разместим компоненты в ручном режиме. В САПР Altium 
Designer имеется возможность автоматического размещения компонентов, при 
этом для схем с небольшим числом компонентов  удобнее пользоваться именно 
ручным режимом. Для размещения компонента необходимо просто выделить 
его и перетянуть в нужное место на плате. При этом заготовка печатной платы 
должна попадать в область Room. Результат ручного размещения компонентов 
приведен на рис. 65. 
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Рис. 65. Размещение элементов на печатной плате 

 
3.2. Автоматическая трассировка печатного монтажа 

  
В состав пакета Altium Designer входит встроенный высокоэффективный 

топологический  автотрассировщик Situs. Работа автотрассировщика 
заключается в анализе топологии платы, подготовленной  к  разводке печати, –  
определении  очертаний  размещенных  на плате  компонентов,  отверстий,  
вырезов,  других  препятствий,  поиске  пути (канала)  для  прокладки  каждого  
очередного  печатного  проводника  и  затем применении целого ряда 
алгоритмов (проходов), в результате чего в найденном канале размещается 
печатный проводник, отвечающий назначенным при настройке  графического  
редактора  печатной  платы  правилам.  Топологические  алгоритмы  
автотрассировки  считаются  более  эффективными,  чем  сеточные и даже так 
называемые бессеточные, нейронные алгоритмы. Рассмотрим основные приемы 
настройки и практического использования автотрассировщика Situs.  

 Командой главного меню Auto Route>Setup или Auto Route>All 
активизировать  диалог  настройки  стратегии  трассировки.  Автотрассировщик 
Situs анализирует  назначенные  правила  и  выстраивает  их  в  стратегию.  В  
поле Routing Strategies диалогового окна Situs Routing Strategies (рис. 66) 
приводится список доступных в текущий момент стратегий и их краткая 
характеристика.  
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Рис. 66. Окно настроек автотрассировщика 
 
Всего по умолчанию предусмотрено шесть стратегий:  
•  Cleanup – подчистка выполненной разводки;  
•  Default 2 Layer Board – трассировка двухсторонней печатной платы; 
• Default 2 Layer with Edge Connectors –  трассировка  двухсторонней платы 

с печатными контактами краевого соединителя;   
•  Default Multi Layer Board – стратегия трассировки многослойной 

печатной платы;  
• General Orthogonal –  стратегия  с  взаимно перпендикулярным  

направлением прокладки проводников;  
•  Via Miser –  стратегия  с  жесткой  минимизацией  числа  переходных 

отверстий. 
После выбора стратегии нажать Route All. Результат автоматической 

трассировки приведен на рис. 67. 
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Рис. 67. Результат автотрассировки 
 

Для передачи чертежа платы в AutoCad надо просто сохранить файл в 
формате DXF/DWG (File/Save As).  

Теперь трассировку печатной платы можно считать завершенной.  
 

3.3. Порядок выполнения работы 
 

Порядок выполнения лабораторной работы следующий: 
1. На базе электрической схемы, полученной в результате выполнения 

лабораторной работы №2 создать проект-заготовку печатной платы. 
2. Получить у преподавателя индивидуальное задание с параметрами 

настройки печатной платы и ее конструктивно-технологические параметры. 
3. Осуществить расстановку элементов на плате в ручном либо 

автоматическом (кластерном) режиме. 
4. Произвести трассировку платы и сохранить полученный результат. 
5. По результатам лабораторной работы оформить отчет. 
 

3.4. Содержание отчета 
 

Отчет по лабораторной работе должен содержать: 
1. Цель работы. 
2. Краткие теоретические сведения. 
3. Последовательность создания печатной платы в виде следующих 

скриншотов: 
3.1. ECO (из Schematic Design>Update PCB Document ‒ Execute). 
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3.2. Переданных элементов в PCB. 
3.3. Расстановки элементов на заготовке платы. 
3.4. Трассировки платы (законченное изображение). 
3.5. Окна экспорта чертежа в AutoCAD. 
3.6. Чертежа платы (распечатка). 

4. Выводы. 
 

3.5. Контрольные вопросы 
 

1. Каковы основные принципы настройки рабочей среды для 
проектирования печатных плат? 

2. Как осуществляется выбор и настройка типа печатной платы при работе 
с мастером PCB Board Wizard? 

3. Каким образом происходит установка основных конструктивно-
технологических параметров печатных плат? 

4. Как осуществляется работа со слоями печатных плат? 
5. Каковы принципы передачи информации из электрической схемы и 

интегрированных библиотек на печатную плату? 
6. Каковы режимы размещения компонентов на печатной плате? 
7. Как осуществляется трассировка печатных плат в ручном 

(интерактивном) и автоматическом режимах? 
8. Каковы основные настройки автотрассировщика? 
9. Как реализуются принципы кластерного авторазмещения компонентов 

на плате? 
10. Как осуществляется передача информации из Altium Designer в 

AutoCAD? 
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